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Cautions for Use 
Please be sure to read and follow the instructions below for safety use. 

 The instructions below are intended to prevent personal injury and property damages. 

 Please read carefully and use the machine properly. 

 
If you don’t follow these instructions, injury or property damage may occur. 

 
If you don’t follow these instructions, users may be seriously injured. 

 Cautions related to power 

 

Do not use damaged cord or 

loosened outlet.   

 It may cause electric shock or 

fire. 

 

Do not put multiple power plugs 

into one outlet simultaneously. It 

may cause fire due to overheated 

outlet. 

 

Do not pull a plug by the cord. Do 

not touch a power plug with wet 

hands. 

 

If you are not going use this 

product for a long time, pull out 

the power plug. 

 

If smoke comes out from the 

engraver during use, turn off the 

engraver immediately and call the 

sales agency or our service 

center.  

  

 

 Cautions related to use 

 

Do not use this machine in a place 

with oil, smoke, humidity, dust or 

water.  

 It may cause electric shock or 

fire. 

 

Do not put a candle or cigarette 

butt on the engraver. Avoid any   

heating apparatus like heater when 

using this machine. 

 It may cause failure or fire due 

to overheating. 

 

Be sure to use the engraver body 

only on a stable level surface. 

 The engraver weights about 28kg, 

and it vibrates left and right 

during operation. Therefore, if you 

use this machine on an uneven 

surface, it may cause damage to 

the surface and products, and 

injury to users. 
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 Cautions related to use 

 

Do not allow any part of body or 

other objects onto the engraver. 

 The cutter of engraver may 

cause serious injury during its 

operation. 

 

 

Do not put water or small metal 

materials on the engraver.  

 Due to negligence or vibration 

of the engraver, the materials 

may fall and cause injury, fire 

or failure by overheating or 

short circuiting. 

 If water gets into the product, 

it may cause electric shock or 

fire. 

 

Be sure not to be caught or 

jammed between the paths of 

each axis of the engraver, or 

scratched by the engraving cutter. 

 It may cause serious injury, or 

damage or failure of the 

engraver. 

 

Laser Radiation 

Avoid eye or skin exposure to 

direct or scattered radiation.  

Class 1 laser product. 

 

 

 Other cautions 

 

Do not disassemble or modify the 

engraver.  

 It may cause fire, electric 

shock or failure. Please 

contact the sales agency or 

our service center for 

Inspection, calibration and 

repair. 

 

Be sure to keep out of the reach of 

toddlers and children. Their 

curiosity or carelessness may 

cause injury. 

 

 

 

During winter, when temperate are 

fall below the freezing point, the 

product may not be normally 

perform. In this case, please keep 

the temperature in the place where 

you use this engraver for normal 

operation. Please make sure the 

temperature in the place where 

you use the engraver does not fall 

below the freezing point. 
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Product Parts and Installation 
1) Parts and Accessories 

MAGIC-70 product box includes the engraver and following accessories. 

Accessories Photos Qty Purpose 

Diamond tip 
(4Φ)  1EA 

Tool for engraving. And ring outer diameter 

engraving. (Spindle) 

Diamond tip 
(3.175Φ)  1EA 

Tool for engraving. And ring inner diameter 

engraving. (L-Tool) 

Endmill cutter 
(4Φ 0.6)  2EA Tool for cutting. (Spindle) 

1.5mm wrench  1EA For changing tools. 

2mm T-wrench 

 

1EA For changing tools. 

Spindle belt 
(60Φ) 

 

3EA 
Silicon belt for transferring DC motor’s 
rotation power to spindle. 

Pin 
 

6EA For holding of irregular shaped material. 

Auxiliary jig  1SET For holding thick engraving materials 

Multi-
performance 

clamp 

 

1EA For holding materials in place. 

Cutting clamp 

 

1SET 
For holding materials in place. 
(Including Bakelite plate) 

Pen clamp 
 

1EA For holding pen. 

Tool top loading 
adapter 

 

2EA  

Finger skin 

 

1SET For protect chuck fingers. 

Pen finger 
 

3EA For holding pen. 
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Flat chuck finger 
 

3EA 
Jig for holding rings when engraving ring’s 
outer diameter or inner diameter of flat 
rings. 

Round chuck 
finger 

(Wide width) 
 

3EA 
Jig for holding rings when engraving ring’s 
inner diameter. 

Round chuck 
finger 

(Narrow width) 
 

3EA 
Jig for holding rings when engraving ring’s 
inner diameter. 

Bangle adapter 

 

3EA 
Jig for holding fingers when engraving 
materials (Bracelets) of a large diameter.  

Chuck handle 
 

2EA Rotation clamp tightening handle. 

Finger spanner 
 

1EA Tool for tightening fingers. 

Nose 

(6Φ) 
 

1EA For depth regulating. 

Tools holder 

 

1EA Storage for tools. 

WD-40 
 

1EA Cutting oils for cutting metal materials. 

Power adapter 

 

1EA DC 24V power supply (24V, 2.5A) 

USB cable 

 

1EA For connecting to PCs. 

Program CD 

 

1EA MagicArt, Design and engraving S/W.  

User’s manual 

 

1EA User’s Manual. 
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※Optional(Separately purchased) 

Flat clamp 

 

1EA For holding material in place. 

2) Specifications 

 

Power supply 100~220V 

Consumption 

voltage 
60W 

Operating range Flat : 140mm(X) x 100 mm(Y) x 38.5mm(Z) 

Rotary: (X) 

 Cylinder outside diameter: Max.93mm 

 Cylinder inside diameter: Min.13mm~Max.93mm 

Resolution 0.005mm (X,Y), 0.00125(Z) 

Weight 31.15Kg 

RPM 9,000~15,000 RPM 

Transfer speed 1 – 36mm/sec (X,Y), 1 – 18mm/sec (Z) 

Temperature 5 – 40 ºC  

Humidity 10 - 90 % 

Purposes Metal engraving, Ring inner diameter, Ring outer diameter engraving, 

Character cutting. 
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3) MagicArt S/W Program Installation 
Place the CD in your computer`s CD driver, Follow the below instructions to install the S/W. Install program will be 

automatically executed and program installation will be progressed in the following order. If Install program is not 

automatically executed after CD is entered, execute Install program on My Computer’s CD drive. 

1. Setup wizard 

 

2. Select installation folder 

 

3. Confirm installation 

 

4. The file is copied onto the hard disk. 

 

5. Click “Close” button to complete program 

installation. 

 

6. Once program installation is completed, USB 

driver Install window appears. Click “Yes” 

button after taking out USB cable. 

 

7. Click “Next” button. 

 

 

8. Click “Finish” button to complete installation 

and re-boot the computer. 
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◈ Program description 

Once the program is installed, the icon below will be created on the desktop. The description of the icon is as 

follows. 

 

◈ Select engraver  

  After installing the program, run the magic art program. Then, the engraver selection window appears as below. 

(When running the program for the first time after installation) 

Select the “MAGIC-70”, and click “OK” button. (Multiple selection available) 

 

 

The engraver selection window can be opened any time through "Tools→ Select engraver in use..." 

from the menu. If necessary, multiple selections with other engravers will be allowed. 

  

 

This is software for design and engraving with features like engraving contents design, 

tool path creating and tool path data transfer. 
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4) MAGIC-70 Installation 
MAGIC-70 is a desktop CNC(Computerized Numerical Control) engraver. This engraver cannot be operated 

independently. You need your machine to be connected to a PC and run with a provided program, in order to 

reform engraving work as you want.  

 

 

 

Insert the provided USB cable into the port on the rear side of the engraver and the USB port of your computer 

respectively.  

[USB cable] 

 

 Connect to the engraver machine             Connect to a PC 

 

 

 

 

 

  

 

 

 

 

 

  

  

USB port 

This is for connecting USB devices. 
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5) Description of MAGIC-70  

 

◈ Parts 

 

    
 

◈ Description of each part 

A Spindle Tightens an engraving tool. 

B Probe Measures a height of engraving material. 

C Tool Length Sensor Measures the height of tool. 

D Pen Clamp Adapter Inserts and holds a pen clamp. 

E Multi performance Clamp Fix the material in place. 

F Clamp Fastening Lever Loosens or fastens the clamp. 

G Emergency Switch Conduct emergency stop.  

H RPM Adjustment Knob Adjusts RPM of engraving tool (9,000~15,000 RPM). 

I Power Switch Turns ON/OFF the machine. 

J L-Tool Tightens the tip used for rings or bangles. 

K Pressure Adjuster Adjusts the pressure of the engraving tool. 

L L-Tool Lock Tightens or adjusts the L-tool. 

M 
Rotation clamp 

(Rotary chuck) 
Tightens a cylinder the materials such as rings. 

N Clamp tightening handle Loosens or tighten the materials 

O Operation key Operates the engraver’s various functions. 

P 5V Port Supplies 5V to the engraver by connecting to power adapter. 

Q Power Port Supplies 24V to the engraver by connecting to power adapter. 

Q 

R 

P 

J 

G

L 

M 

 

C 

A 

E 

B 

N 

F

K 

H

I

D 

 

O 

http://dic.daum.net/word/view.do?wordid=ekw000001835&q=%EC%95%84%EB%8B%B5%ED%84%B0
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R Communication port Connects USB cable to the computer. 
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◈ Description on Keys 

 

 

STOP 
Once this button is pressed during engraving, all operations 

in progress will stop. 

VISE 

If you press and hold the button, it enters into tool settings 

mode. If you lightly press the button, the clamp moves back 

and forth. 

 

ROUND CHUCK 
FINGER 

If the button is lightly pressed, the laser point is moved to 

round chuck finger Origin point. 

If the button is pressed and held for more than one second 

after the round chuck finger Origin point is changed, then the 

changed Origin point will be saved. 

 

FLAT CHUCK 

FINGER 

If the button is lightly pressed, the laser point with be moved 

to flat chuck finger Origin point. 

If the button is pressed and held for more than one second 

after the flat chuck finger Origin point is changed, then the 

changed Origin point will be saved.  

 
DIRECTION KEY(A) 

Make rotation clamp rotate. 

※During the rotation, it stops when it reach 0°, 90°, 180° or 

270° location. 

 
DIRECTION KEY(Z) Move Z axis to up and down 

 
POINTER Turns laser pointer ON/OFF. 

 

START 

If this button is pressed and held for more than one second 

after engraving, then the data is sent and the area is 

designated, engraving will start. 

SAVE 

If the button is pressed and held for more than one second 

after the tool setting is changed, then the changed setting 

value will be saved. 

MENU 

Enter the menu. 

※ Please consult with engineers before to use this 

function. 

 

DIRECTION(X, Y) 

It moves the tool or laser pointer. 

During engraving, press   button to raise the speed by 

one level, and press  button to slow down. 
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CLAMP Moves the Multi-performance clamp. 

 

RING OUTER 

DIAMETER 

Moves the ring outer diameter engraving position of the 

rotating clamp. 

 

RING INNER 

DIAMETER 

Moves the ring inner diameter engraving position of rotating 

clamp 

 

◈ Engraver movement 

When the engraver is turned on, the engraver begins the self-test in the following order, and it enters into waiting 

mode with confirmation sound if there is no problem. 

 

(1) The order of self-test when the machine is turned on 

1) If a certain axis is detected by the sensor, move to leave from the detected area.  

2) Check probe sensor and return to the Origin point 

3) Check Z-axis sensor and return to the Origin point 

4) Check X-axis sensor and return to the Origin point 

5) Check Y-axis sensor and return to the Origin point 

6) Wait for confirmation sound  

 

(2) The sequence of instruction for engraving set up 

1) Turn on the engraver. 

2) Place to secure the materials to be engraved on the clamp of the engraver. 

3) Run the design software (provided with the product). 

4) Prepare the contents of engraving. 

5) Press the engraving button on the program to transfer intended data to the machine.  

6) Press the start button on the machine to begin the engraving process. 
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◈ Description on Menu 

If press the button, entering to the menu mode. It is same function of operation keys. Press and hold the 

button  for more than 3 seconds to enter each menu. 

 

 

Exchange the tools. 

 

Check XY coordinate. 

※If the machine is restarted, set value is reset. 

 

Check Z coordinate. 

※If the machine is restarted, set value is reset. 

 

Check A coordinate. 

※If the machine is restarted, set value is reset. 

 

Select the measurement 

option the material’s height. 

Surface Height/ Horizontal, Shape 

Verticality, Shape/ Surface Slope 

 

When repetitive work, Select 

the measurement option of 

material height and engraving 

area. 

1. Skip the all measurements.   

2. Measure the height. 

3. Check the all measurements. 

 

Select how to check the 

engraving area before starting 

to engrave ring inner diameter. 

 

Spindle test is running. 
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ON 5V output of      

the machine. 

※ The port on the backside of 

machine can output 5V. It can control the power of buzzer, 

vacuum device, etc.     

 

 

Select the language. 

 

 

 

Select the calibration mode. 

 

  

1. Origin No: 0(Center)~8  

User can set and save your own origin. 

2. Clamp No: 1~10  

For each clamp, you can select 0 ~ 8 origins. 

10 clamps can be saved at the maximum. 

※The menu cannot be shown in the ring inner/outer diameter 

mode. You can use it in flat mode. 

 

Set revolution and speed to spin the rotary chuck. 

 

※ Millgrain tool cab engrave repeated patterns on the ring 

outer diameter. 

※Millgrain tool is not included. You can purchase at store. 
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◈ Measurement Select 

User can select measurement mode within two seconds before measurement begins, after transferring tool path 

(engraving data) from MagicArt to the machine. 

 

 

 

 

 

 

 

Measure the origin of engraving area. 

 

Measure the beginning point. 

 

Measure whenever tool moves and meet the material.  

※ “Z Clearance” should be set enough large value when setting the tool path 

to avoid damage material. 

 

Measurement Method Select.  

If you select probe, “Measure the origin of engraving area” mode is 

automatically selected and the others cannot be selected. 

 

 

  

: Select Measurement Mode  

: Select Probe/Touch 
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6) How to Use the Clamp 

◈ Multi performance Clamp 

The holding part of clamp is step type, so set the clamp to the step to match the size and thickness are matched. 

If you turn the clamp handle to the left, then the clamp will be loosed and turn it to the right, then the clamp will be 

tightened.  

When holding the materials by turning the clamp tightening handle, a mark may be left on the 

materials. 

           
 

◈ Adjusting the Height of the Clamp 

The height of the clamp can be adjusted depending on the thickness of the materials or the type of clamps. 

             

           

 

 

◈ How to use the pin 

 Pin holes on the clamp ensures easier holding of irregular shaped material. 

             

 

◈ How to use the gradation on the clamp 

 Gradation on the clamp also helps easier positioning of material on the clamp. 

Turn the clamp knob upward to 

pull out the spacer block. 

Remove the spacer block. Insert the clamp. 
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◈ How to attach the auxiliary jig 

The auxiliary jig helps to hold thick materials like a beer bottle. As a pair, the Auxiliary jigs are holed by bolts 

on each hole. 

             

              

 

 

 

 

 

 

◈ Rotation Clamp(Chuck) 

-Holding method for outer diameter engraving 

Insert the ring until it clicks into the flat chuck finger and turn the chuck handle to hold the ring and not to allow it 

come out or spin. 
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-Holding method for ring inner diameter engraving 

Open the chuck finger of the rotation clamp and insert the ring, and use the chuck handle to hold it not to allow it 

to come out or slip. 

        Ex) Flat chuck finger 

              

 

  

                                  

There are three types of chuck fingers. According to the shape of ring, use chuck finger appropriately to 

hold the ring and not allow it to become loose or fall. 

 

       

          Flat chuck finger         Round chuck finger (wide width)     Round chuck finger (narrow width) 

 

- Chuck finger changing method 

Use the chuck finger spanner provided along with the product to release or tighten the chuck finger. 
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If the thickness of ring is not even, mix different sized chuck fingers to hold it. 
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- Materials holding methods for engraving bracelets 

Place three bangle adapters in the rotation clamp, and tighten the chuck finger in front of the bangle adapters. 

Open the rotation clamp to match it to the bracelet size, and insert the bracelet until it clicks into the chuck finger. 

Use the chuck handle not to make bracelet come out or spin. 

 

 

 

                   
 

◈ Pen Clamp 

1. Turn the clamp knob on the left side of the clamp and pull the clamp and spacer block to take it out.  

 

 

 

 

 

 

2. Place the pen in the flat chuck finger of the rotation clamp, and insert the pen clamp into the pen clamp adapter. 

Push the clamp until it touches the pen fixed in the chuck finger. Tighten the bolt on the pen clamp adapter not the 

pen clamp to be pushed, and tighten the bolt of the pen clamp to securely hold the pen. 

      

 

  

Chuck Finger Bangle Adapter 
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◈ Cutting Clamp 

Release four tightening bolts on the cutting clamp, and insert the Bakelite plate. Put materials on the Bakelite plate 

and tighten with bolts. Open the clamp wide at the maximum, and put the clamp dedicated to cutting on it, and 

tighten it. 

[Cutting exclusive clamp] 

 

 

 

 

 

1. Turn the clamp knob on the left side of the clamp. Turn the clamp tightening handle for widen the gap of clamp. 

   

 

2. Insert the cutting clamp, and tighten the clamp by turn the clamp tightening handle. 
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◈ Flat Clamp (Separately purchased) 

   

※ Is secured on the base table by using 4 bolts at each corner of the clamp. 

 

1. Turn the clamp knob on the left side of the clamp and pull the clamp and spacer block to take it out. 

              

2. Insert the flat clamp, and tighten the clamp by turn the clamp knob. 
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7) Changing Tools 

◈Spindle 

1. Press  button and go to the menu mode. 

2. Press  button, and when  menu appears on the LCD window, then press 

and hold  button until it beeps (more than 3 seconds) to run the menu. 

 

3. Just like the below figure, insert it to 1mm wrench on tool fixing bolt. Turn wrench to the left and loosen bolt. 

Grab tool by hands in advance in order that tool is not fallen on the bottom and pull out tool downward by pushing 

tool from the top. After changing tool, tighten it by using wrench bolt and fix it 

 
When loosing tool fixing bolts, hold the tool with your hands and loose the bolts to avoid 

dropping the tool on the floor and causing damage to it.  

 

4. Press the  button until it beeps (more than 3 seconds) to measure tool’s lengh automatically. 

 

◈ L-Tool 

Just like the below figure, insert it to 1mm wrench on tool fixing bolt. Turn wrench to the left and loosen bolt. 

Grab tool by hands in advance in order that tool is not fallen on the bottom and pull out tool downward by 

pushing tool from the top. After changing tool, tighten it by using wrench bolt and fix it. 
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8) Replacing the Spindle Belt  
 

The spindle belt transfers the rotation power of the spindle motor to the spindle to turn the 

engraving blade. If the spindle belt is worn, the surface is cracked and slippery. So it cannot 

deliver the power of the spindle motor properly. In this case, the number of rotation decreases, 

or it causes poor engraving quality. 

Replacement Cycle: 

The lifespan of the spindle belt varies depending on usage and conditions. Generally, it should be changed every 

2-3 months. 

Spindle Belt Replacement Method 

There is a red rubber belt on the front head of the engraver. Replace this belt with new belt. 

 

 

9) Tension  

◈ Setting Engraver Pressure Lock 

When cutting materials or engraving materials with a V cutter, set the head and remove the pressure lock. Then, 

vibration during engraving will be reduced and it will improve the quality of engraving or cutting and extends the 

life cycle of the tool. Release the bolts as shown in the picture below and insert the hole in the back and turn it to 

tighten.  

                

After that, when engraving with the Carbide tip tool, it needs more pressure. So this bolt should 

be released and moved to the left hole. 

 

  

Spindle belt 
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◈ Pressure Adjuster 

When engraving with a Carbide tip, the engraving depth is adjusted with pressure. This is the using same as the 

engraving depth selection when creating the tool path. If you turn the tension adjustment knob to the right, the 

pressure increases stronger, and turning it to the left, decreases the pressure. 
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Program Usage Description 
Run the program, then a window show up as below. The program window is different between when an object is  

selected and not selected. The names of parts for each case are as follows. 

 

◈ Program screen 

 

◈ Character input mode 

 Press  [Text Input] button and click the screen or double click mouse left button on the selection mode 

to switch to character input mode. 

 

Cursor (character input mode) 

Character registration information 

Template category 

Menu 

Work area 

Template list 

Toolbar 

Design sample

인 샘플 
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◈ Object selection mode 

After entering texts, click [Selection] button with a mouse or click the work area with mouse right button. Then, 

the entered character object is selected and it turns into selection mode. Double click mouse left button in the 

selection mode to convert it into character entering mode. 

      

◈ Object rotation mode 

If the selected object is clicked once more with the mouse, the mode will be converted to the object rotation mode. 

  

Object registration information 

Select object 

Rotation registration information 

Object rotation mode 



 

 32  

1) Toolbar 

  

◈ Alignment tools 

  

 [Line/Curve] 

 Click a certain point with the mouse and move it to make a dot line appear. 

Designate the distance and click with the mouse and then press the right 

button on the mouse to create a straight line. At this time, press “Ctrl” key on 

the keyboard and move the mouse to create a horizontal line or a vertical 

line.  

 

Click on a certain point with the mouse and designate a distance. Drag while 

clicking and holding the mouse to make a curve appear. Press the right 

button on the mouse to create the curve. 

 [Circle/Ellipse/Pie] 

 

Click and hold the work area with the mouse and drag it to designate the size 

of a circle. At this time, press “Shift” key and drag it to create a perfect circle.  

 

Click  button on the circle object registration information to transform 

into an arc. The starting/ending degree can be designated and those degrees 

can be adjusted by dragging The starting/ending degree of the arc with the 

mouse. At this time, click  button to create a reversed 

image.   

  

Click  button on the circle object registration information to transform 

into a pie (a filled arc). The starting/ending degree can be designated and 

those degrees can be adjusted by dragging The starting/ending degree of 

the pie with the mouse. At this time, click  button to 

create a reversed image.   

[Adds a rectangle] 

 

Click and hold the work area with the mouse and drag it to designate the size 

of a rectangular.  

At this time, press “Shift” key and drag it to create a square. 
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Determine the curvature of each edge on the rectangular object registration 

information or drag the rectangular edge with the mouse to transform it into 

a round rectangle with round corners. 

 

Click   button on the rectangular object registration 

information and adjust the curvature of each corner individually.  

 

[Polygon] 

 

Click and hold the work area with the mouse and drag it to designate the size 

of a polygon. 

At this time, specify the number of vertical on the polygon object registration 

information to change it.  

 

[Mirror] 

          
Left/right reverse the selected object. 

 

[Rotation] 

          

If the selected object is clicked once more with the mouse, 

it will convert to the object rotation mode. Then, rotate the 

object by dragging it with the mouse or arrow keys on the 

keyboard. 

 

[Invert color] 

          

Reverse the color of the selected object. 

 

[90˚CW] 

           

Rotate the selected object by 90˚.  
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[Vertical center in page] 

           

[Horizontal center in page] 

            

[Center in page] 

            

 

          

 

Alignment 

 Align to the left of base object 

 Align to the center of base object 

 Align to the right of base object 

 Align to the top of base object 

 Align to the center of base object 

 Align to the bottom of base object 

Adjust horizontal gap  Distribute horizontal gap 

Adjust vertical gap  Distribute vertical gap 

 

Same size 

 Distribute width 

 Distribute height 

 Make same size 

Order 
 Bring to front 

 Send to back 
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[Left top Origin point] 

 

[Left bottom Origin point] 

 

[Center Origin point] 

 

  



 

 36  

◈Object tools 

 

[Template] 

Either import a template or save the currently selected object as a template. 

 

What is a template?  

Template is an image of materials to be engraved. The engraving is actually done as same as 

the design on the template. 

           Template is not selectable by mouse, but you can select it by dragging it while pressing “Shift” key 

on a keyboard. 

 

[Design sample] 

Import design sample or save current object as design sample. 

 

What is a design sample? 

It means design objects saved in the design sample library. The design sample can be always 

easily and quickly imported from the design sample library and freely edited. 
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[Selection] 

It is available either to select the object created in the work area to adjust its size and location or to change the 

object’s property. Only the selected objects are subject to changing their location/size/size and engraving. In 

the character input mode, converting to any selection mode easily by pressing the right button of the mouse. 

                

[Select object]                                    [Select no object] 

 

[Text input] 

If  button is pressed and then the work area is clicked with the mouse, characters can be entered. Double 

clicking the left button of the mouse in the selection mode is an easier way to convert into the character input 

mode. 

                

 

Press  button and drag a character to be edited with the mouse for partly selection. Then, adjust its font 

and size. 

 

 

 

 [Circular text] 

Create character objects along a circle. 

 

 

  

[Mouse drag] 

Cursor (Character input mode) 
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[Drawing pen] 

You can draw by dragging the mouse.  

The thickness of drawing line can be adjusted in the drawing object information window. 

   

[Image] 

Import image (bmp, jepg, gif, png … etc.) 

 

[Line eraser] 

Clear the line of object.  

Move the mouse over the line of object. The line will be removed (Some objects cannot be removed with the 

Clear line tool) 
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[Cutting tool path] 

Create a tool path that will engrave the selected object’s border. 

          

 

[Hatching tool path] 

Create a tool path that will engrave the inside of the selected object. 

         

 

[Single line tool path] 

Create a tool path that will engrave the center line of the selected object. 

     

 

[Text input engraving tool path] 

Create a tool path that will engrave the inside of the selected object with dots. 

    

 

[Simulate tool path cut] 

The prospected image of the result of tool path processing done by the selected tool is shown. 

The following is an example of the cutting tool path that uses 0.6mm End mill. 
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[Show tool path only] 

Only tool path is shown on the screen with temperately masking all of other objects. If this button is pressed 

once again, all objects will be seen again.   

           

 

[Instant engraving] 

Immediately engrave the selected object without creating a tool path. Select an engraving method from the 

engraving selection list on the Engrave window and select engraving options and measuring methods before 

clicking “Start Engraving” button. 

 

 

[Engrave] 

Engrave the selected tool path. 
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◈ Basic tools 

 

 

 

[New document] 

Open a new file 

  

 

[Open] 

Import a file save in *.dgn. 

Select a file on the “Open” window and click “Open” button. 
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Ctrl + X Ctrl + V 

[Save document] 

Save the design drawn on program by ” *.dgn.” 

Chose the location (folder) in which the file will be saved and enter the file name before clicking “Save” button. 

 

[Print] 

Print the design drawn on program. 

 

[Cut]  

Cut the selected object.  

If Ctrl+X is pressed on the keyboard, the same function will be executed.  
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Ctrl + C 

[Copy] 

Copy the selected object.  

If Ctrl+C is pressed on the keyboard, the same function will be executed. 

 

                         

 

 

[Multiple paste] 

If more than one of the same object is needed, multi-copy the object in several constant gaps by clicking Edit 

menu → Copy → Multiple Paste….  

 

             

 

      

 

[Paste] 

    Paste the cut or copied object. 

If Ctrl+V is pressed on the keyboard, the same function will be executed. 

Ctrl + V 
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    [Undo] 

Return the work recently done to its previous state.  

The number of undo stage can be adjusted with Tools → Option → General.  

             

 

[Redo] 

Re-execute the undone work.  

                

 

                                                                  

 

 

  

Change font Undo 

Redo 

Change font 
Undo 
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◈ Screen Zoom In/Out/Move Tools 

[Zoom in] 

The screen is zoomed in by one level. 

         

[Zoom out] 

The screen is zoomed out by one level. 

           

[Zoom in/Out ratio] 

If any screen ratio is selected, the screen in the size of the selected ratio will be seen. 
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[Magnifier] 

Drag a certain spot with the mouse to enlarge it.  

           

[Fit to object] 

Enlarge the selected object to make it filled with the screen. 

           

[Fit to page] 

Adjust the page size to see the whole work area.  

   

[Panning] 

Drag the screen with the mouse to move it. 
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2) Registration Information of Character Object 
If any character object is selected, the registration information of character object will appear in the left of the 

screen.  

 

[Font] 

Designate font. 

Either click the font’s arrow or click Preview button to designate font. 

 

        [Size] 

Adjust the size of the selected character size. Either press the size arrow button to select or press  

[size] button to adjust the size by one level. 
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[Bold] 

Change character style to bold.  

            

[Italic] 

Change the character style to italic. 

            

[Reduce or increase font weight by one level] 

Adjust the weight of font. 

                      

[Symbol] 

Insert symbols. 
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[Text change] 

The entered text of the selected object can be displayed and changed. Press  button to change the text 

more easily.  

 

 

 

 

 [Align to left] 

Align characters to the left in the text box. 

 

[Align to center] 

Align characters to the center in the text box. 

 

[Align to right] 

Align characters to the right in the text box. 

 

[Both] 

Align characters to the both direction evenly in the text box. 
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 [Align to top] 

Align characters to the top in the text box.

 

 [Align to center] 

Align characters to the center in the text box. 

 

 [Align to bottom] 

Align characters to the bottom in the text box. 

 

 [Horizontal text ] 

Arrange characters horizontally. 

 

 [Vertical text] 

Arrange characters vertically. 

 

 

Move the selected character horizontally (left, right). 

 

 

 

Move the selected character vertically (up, down). 

 

 

Adjust the width of the selected character. 
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Rotate the selected character. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

Location of the selected object 

 

Size of the selected object 

 Line thickness of the selected object 

 
Line type of the selected object 

 Line color of the selected object 

 
Color filled inside of the selected object 

 Type of filled inside of the selected object 
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3) Registration Information of Rotation 

 

 

 

 

 

  

 

Rotate the selected object by one degree. Enter the desired angle of 

rotation, and press button, then the object is rotated by the angle you 

enter. 

 

Rotate the selected object at the same degree as entered. 

 

Rotate and add a new object at the same degree as entered 
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4) How to Engrave for Each Tool Path 

 

   

 

 

[Content] 

 

Cutting 

Engrave the border of characters. 

 

 

 

Hatching 

Engrave the inside of characters. 

 

 

 

Single line 

Engrave the center of characters. 

 

 

 

 

Engrave the surface of characters 

character with dots. 
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5) Create Tool Path 

 

 

 

 

Preset 

Hatching gap, depth, engraving speed and others are pre-set for each 

engraving option. Therefore, it is not necessary to designate hatching gap, 

depth, engraving speed and others every time and they will be automatically 

set with their pre-set values. Each engraving option value can be changed by 

pressing Edit or Add button on the Set engraving option window. 

Tool 
Designate a tool to be used for engraving. Each tool setting value can be 

changed by pressing Edit or Add button on the Set tool window. 

Direction 

 

The followings are shown only on hatching tool path. 

A tool path is created in the horizontal direction   

A tool path is created in the left diagonal direction . 

A tool path is created in the right diagonal direction  

A tool path is created in the cross hatched direction . 

Depth 

Engraving: It does not mean the actual engraving depth but refers to “Applied 

pressure” and the higher depth value is, the bigger the applied 

pressure is.  

Cutting: Designate an engraving depth actually used for using rotation tools. 
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Engrave outline  

If engrave border is cancelled, a tool path will engrave only the inside of the 

character created.  

        

Z Clearance 
When moving to another engraving location, it is necessary to lift Z axis to 

prevent the tool from contacting with the material surface before moving. For 

this, designate the height to be applied at this time. 

XY axis speed Designate a speed at which XY axis will move during the engraving. 

Z axis speed Designate a speed at which Z axis will move during the engraving. 

Hatching interval 

Designate hatching gap. 

 

0.1mm       0.2mm      0.3mm 

Margin 

Designate a margin between object outline and tool path. 

 

0.1mm       0.2mm      0.3mm 

Show briefly Only engraving option, direction and tool of the tool path are shown. 

Transmit  Transfer tool path window is displayed 
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5-1) Engraving Option: Add/Delete/Edit 

If Select engraving option is checked, Add/Delete/Edit buttons will appear. 

 

 

 Enter a name to the engraving option setting window and designate hatching gap, engraving depth 

and speed before clicking “OK” button. They will be added to the engraving option selection list.  

  

 Select an option to be deleted and click “Delete” button to delete the option from the list.  

            

 

 Select an option to be modified and click “Edit” button. If “OK” button is clicked after a setting value 

is modified on the option setting window, the modified setting value will be saved.  
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5-2) Add/Delete/ Edit Tool 

If “Edit” button is checked, Add/Delete/Edit button will appear. 

 

 Designate the name of a tool to be added along with its type, end width and click “OK” button. The 

tool will be added to the tool selection list. 

         

 Select a tool from the list and click “Delete” button to delete the selected tool from the list. 

              

 Select a tool to be modified and click “Edit” button. If “OK” button is clicked after a setting value such 

as edge width is modified, the modified setting value will be saved.  
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6) Registration Information of Tool path 
If tool path object is selected, the registration information of tool path window will appears in the left of the 

screen to allow the user to adjust its depth and speed once again.   

 

 

Depth 

Engraving: It does not mean the actual engraving depth but refers to “Applied 

pressure” and the higher depth value is, the bigger the applied pressure 

is.  

Cutting: Designate an engraving depth actually used for using rotation tools. 

XY speed Designate a speed at which XY axis will move during the engraving. 

Z speed Designate a speed at which Z axis will move during the engraving. 

Z Clearance 

When moving to another engraving location, It is necessary to lift Z axis to prevent 

the tool from contacting with the material surface before moving. For this, 

designate the height to be applied at this time. 

Z Dwell Time Designate time gap before Z axis touches the material and it is moved.  

Engrave twice Engrave the design twice.  

 

  

 

The location of the selected tool path appears. Click the arrow button to 

move the location.  

 

The overall size of the selected tool path appears. Click the arrow button 

to change the size.  
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7) Transfer NC data  

Transfer the selected tool path to the engraver. Select a tool path object and click  button to 

make the transfer NC data window appear. Select a measuring method and click “Start engraving” button. 

 

 

 

Surface height 

Measure material height only. 

 

 

 

Horz. slope 

Measure material’s horizontal gradient. 

 

 

 

 

 

Surface slope 

Measure material’s top, bottom, left and right gradient. 

 

 

 

 

Skip 

Do not measure its height. In this case, the height previously measured can 

be used. If the material is not removed from the clamp during the previous 

engraving work, the measuring time can be saved with this option.  

Adjust engraving 

Position 

Designate whether to re-adjust the engraving location. If this option is 

selected, the laser pointer will be turned on to allow the user to adjust the 

engraving location before engraving. If this option is not used, engraving will 

begin immediately.  
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Surface height 

Measure material height. 

 

 

 

 

Multi point 

measurement 

Measure material height by dividing the whole material into several parts(up 

to 5 times) 

Outside Engrave on the ring’s outer diameter. 

Inside Engrave on the ring’s inner diameter. 

 
Place the material to the flat chuck finger. 

 
Place the material to the round chuck finger. 
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Engraving Process 
 

 

 

 

1. Measure material to be engraved. 

 

 

 

 

 

 

 

2. Fix a material to be engraved to the center of clamp. 

 

 

3. Select the template the most similar to the material to be engraved from the template category and enter the 

size of the material before clicking “OK” button. 

 

 

  

Vertical 

Horizontal 

Tool: Tip 

Clamp: Multi performance clamp 
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4. Once the template appears, press  [Text input] and click any wanted location with the mouse to enter 

characters. 

  

5. Once entering characters is completed, press toolbar’s  [Selection] and go to the select object mode to 

select the entered characters. Then, edit the size, font and thickness of the object. If you want to allocate the 

object at the center of the work area, click  [Center in page] button. 
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6. Once the design is completed, click [Hatching tool path]. A tool path means a route along which a tool is 

moved for engraving. 

  

 

7. Select an engraving option and tool from “Hatching tool path” window and if necessary, designate gap and 

depth before clicking “Create tool path” button. 
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8. “Tool path” object is created. 

   

9. Click [Engraving] button.  

 

 

10. Once “Output” window appears, specify how to measure the engraving materials. And then, click “Start 

engraving” button. 
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11. Once the tool is moved to the center of the material and stopped, the engraving area can be verified and 

adjusted by using the direction key button. At this time, check the laser pointer while moving it for easier 

measurement and adjustment. 

 

 

Whenever the direction key is pressed, move the laser pointer to the left, top, right 

and bottom of the engraving area to show the area to be engraved. Check whether 

the area to be engraved is outside of the materials surface. If so, adjust the location 

by using the direction key.  

 

The laser pointer moves the area to be engraved to the left, top, right or bottom 

according to current location. If the current location of the laser pointer is left, then, 

press  key to move the area to the left. 

 

 

 

 

 

 

 

12. After the location of engraving is decided, press and hold  button until it beeps (more than 3 seconds) 

to start the engraving. 

13. User can select measurement mode within two seconds before measurement begins, after transferring tool 

path (engraving data) from MagicArt to the machine. 

 

 

 

 

 

 

 

Measure the origin of 

engraving area. 

Measurement Method 

Select.  

Work area 

 

: 측정 모드 선택 

: 프로브/터치 선택 
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Measure the beginning point. 

 

If you select probe, 

“Measure the origin of 

engraving area” mode is 

automatically selected 

and the others cannot be 

selected.  

Measure whenever tool moves 

and meet the material.  

※ “Z Clearance” should be set 

enough large value when setting the 

tool path to avoid damage material. 
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1. Measuring the width and diameter of a ring to be engraved. 

 

 

 

2. Insert the ring into the chuck finger as below, and tighten the rotation clamp to set it. 

                       

               Outer diameter                              Inner diameter 

 

Since the character engraving direction is as shown in the picture below, check out the direction 

of the materials and set it. 

 

 

  

  

Width 

Diameter 

Tool: Tip 

Clamp: Rotation clamp 

A
B
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◈ Ring (Bangle) Outer Diameter 

1. Press button on the engraver. A message requiring removal of the clamp appears on the screen. 

 

※ Proceeding without removing the clamp, a damage may occur in the clamp and other tools.  

 

2. Remove the clamp by loosening the clamp tightening lever.  

              

3. Press button after removing the clamp. A message shown below appears on the screen.  

   

 

                  

[Ring Outer Diameter]       [Bangle Outer Diameter] 
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◈ Ring (Bangle) Inner Diameter 

 

Use an L-tool to engrave ring or bangle inner diameter. 

1. Press  button on the engraver. A message requiring removal of the clamp appears on the screen. 

 

2. Remove the pendant clamp by loosening the clamp tightening lever.  

                

3. Press  button after removing the clamp. A message shown below appears on the screen.  

 

 

4. Loosen the L-tool tightening bolt by turning it in the direction shown in the following picture.  
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5. Adjust the height of L-tool to get a proper height for the engraving. With the L-tool at a proper height, fix it with 

the L-tool tightening bolts. 

 

 

 

 

 

 

 

 

 

 

 

 

The length of the L-tool fixture should be flexible to meet the shape of the bangle. Please 

fix L-tool properly to the shape of the bangle. 

 

6. Press  button, a message shown below appears on the screen. Now all is done to start the work. 

 

 

 

            

[Ring Inner Diameter]       [Bangle Inner Diameter] 

 

  

 

Bangle inner diameter 

Ring inner 

diameter 
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◈ Program Process 

1. Double click “Ring” template in the object registration information. 

  

 

2. When “Insert Rotary Object Template” window appears, enter the width and diameter of the ring measured and 

click “OK.” 
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3. The template appears at the center of the screen. 

  

 

4. Select [Text Input] from the menu, and click the work area using mouse and enter the characters to be 

engraved. 
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5. After entering characters, press [Selection] in the toolbar to enter the object selection mode. Select the 

character string, and edit the size and font of the object. If you want to place the object at the center of the work 

area, click [Center in Page] button. 

      

6. Once design is completed, click [Hatching Tool path] button.  

    

  

Handle to adjust 

character gap 
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7. Once “Hatching Tool path” window appears as shown in the picture below, select tool, tool path gap and 

depth, and click “Create Tool Path” button. 

  

 

8. The “Tool path” object is created as below and marked with red line on the screen. Turn the mouse wheel to 

enlarge the tool path object, and if it is not the tool path you want, delete the tool path and extract it again by 

adjusting the extraction option. 

      

                          [Extract tool path ] 
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9. After selecting a tool path, click . 

      

 

10. Once “Transfer NC data” window appears, specify Communication port and rotation clamp option. And then, 

click “Start Engraving” button.  

 

 

 

Surface Height 

Measure material height. 

 

 

 

 

Multi point 

Measurement 

Measure material height by dividing the whole material into several parts(up 

to 5 times) 

Outside Engrave on the ring’s outer diameter. 

Inside Engrave on the ring’s inner diameter. 

 
Set the material to the flat chuck finger. 

 
Set the material to the round chuck finger. 
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11. Once the tool is moved to the center of the materials and stopped, the engraving area can be verified and 

adjusted by using the direction key button. At this time, check the laser pointer while moving it for easier 

measurement and adjustment. 

 

 

Whenever the direction key is pressed, move the laser pointer to the left, top, right 

and bottom of the area to show the area to be engraved. Check out whether the 

area to be engraved is out of the materials surface. If so, adjust the location by 

using the direction key. 

 

The laser pointer moves the area to be engraved to the left, top, right or bottom 

according to current location. If the current location of the laser pointer is left, then, 

press  key to move the area to the left. 

 

 

 

 

 

 

 

 

14. After location of engraving is decided, press and hold  button until it beeps (more than 3 seconds) to 

start the engraving. 

 

15. Close the engraver cover. 

 

  

Work Area 
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Tool: Endmill Cutter      

Clamp: Cutting clamp 

Other: Apply cutting oil on the surface of materials to improve engraving 

quality and extend the lifespan of Cutter 

Character Cutting Process 

            

 

Replace the tool with a cutting tool, and press the tool exchange button to measure the tool depth. 

Also, be sure to set the head by tightening the engraver pressure lock. If you do not fix the head, 

it may cause uneven engraving depth or damage to the tool. 

 

                

. 

1. Measure the thickness of a material to be cut. 

 

 

 

 

 

2. Place and fix a material to be cut on the cutting clamp and place and tighten it on the clamp.  

 

 

 

 

 

3. Press [Text Input] in the toolbar to enter the character input mode, and click the position of the work area you 
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want and enter the characters. 

      

4. After entering characters, press [Selection] in the toolbar to select character string and designate the font. 

   

 

Adjust the character to the size you want. Adjust the size by using an object handle as below, or adjust the size 

from the left object registration information window. 

 

 

 

 

 

  

Object Handle 
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5. Drag the character gap adjustment handle (a square in the picture below) with the mouse to narrow the gap 

between the characters. 

 

 

If the gap of some characters is partially adjusted, press [Text Input] button and drag the mouse to select what 

you want. Drag a character gap adjustment handle by the mouse and adjust the character gap. 

 

①            ②    

       [Design character]               [Press button and click with the mouse] 

③       ④  

         [Select character]                     [Adjust character gap]      

 

6. Once design is completed, click [Cutting Tool path]. A tool path means a route along which a tool is moved 

for engraving.  

   

  

Adjust character gap 
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7. Once the “Cutting Tool path” window appears as seen in the figure below, select cutting depth (material thickness 

+ 0.1~0.2mm) and tool diameter and click “Create tool path.”  

       

 

 

  

                                                                          

                                                    

 

 

 

 

 

Depth 

Designate the thickness for cutting. Since material may be bent or slanted, the 

depth should be 0.1-0.2 mm deeper than the thickness for perfect cutting. 

Z Pitch 

When cutting the engraving depth little by little, designate the depth. When cutting 

thick materials with a thin tool, it is useful. 

XY axis speed Designate a cutting speed. 

Z axis speed 

Designate a speed at which the tool punches and penetrates the material and 

descends during the engraving. 

Z Clearance 

When moving to another engraving location, it is necessary to lift Z axis to prevent 

the tool from contacting with the material surface before moving. To do this, 

designate the height to be applied. 

Z Dwell Time 

If the tool touches materials, the rotation speed will be slower. If moved quickly at 

this time, the tool may be damaged. In particular, in case of metal materials, wait 

until the spindle rotation speed is restored to prevent damage to the tool. Enter the 

delay time. 

Transmit “Transfer tool path” window is displayed. 
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8. “Tool path” is created. 

  

9. Click  button. 

 

 

10. Once “Output” window appears as seen in the figure below, specify how to measure Communication port and 

material. And then, click “Start engraving” button.  

   

 

 

 

 

How to measure a material 
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Surface Height 

Measure material height only. 

 

 

 

Horz. Slope 

Measure material’s horizontal gradient. 

 

 

 

 

Surface Slope 

Measure material’s top, bottom, left and right gradient. 

 

 

 

 

Skip 

Do not measure its height. In this case, the height previously measures can 

be used. If the material is not removed from the clamp during the previous 

engraving work, the measuring time can be saved with this option.  

Adjust Engraving 

Position 

Designate whether to re-adjust the engraving location. If this option is 

selected, the laser pointer will be turned on to allow the user to adjust the 

engraving location before engraving. If this option is not used, engraving will 

begin immediately.  
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11. If the tool is moved to the center of the material and stopped, the engraving area can be verified and adjusted 

by using the direction key button. At this time, check the laser pointer while moving it for easier measurement and 

adjustment. 

 

 

 

Whenever the direction key is pressed, move the laser pointer to the left, top, right 

and bottom of the area to show the area to be engraved. Check whether the area 

to be engraved is outside of the materials surface. If so, adjust the location by using 

the direction key. 

 

The laser pointer moves the area to be engraved to the left, top, right or bottom 

according to current location. If the current location of the laser pointer is left, then, 

press  key to move the area to the left. 

 

 

 

 

 

 

 

 

 

12. After location of engraving is decided, press and hold  button until it beeps (more than 3 seconds) to 

start the engraving. 

 

13. Close the engraver cover. 

 

  

Work Area 
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Engraving by Using Nose 
Nose is a sub-component to support engraving along with the curved surface of material. Therefore, it is possible 

to engrave on the curved surface of material with consistent depth by using the nose.  

 

 

 

 

Be sure to release the engraver pressure lock. If you engrave with fixing head, the nose, tool and 

materials may be damaged. 

            

1. Replace the tool with V cut tool and conduct automatic measurement of tool length.  

 

2. Turn the depth nose lock to left and loosen the bolt. Turn the nose height adjustment screw the left and lower it 

down about 1~2mm.  

 

  

Tool: V cut tool 

Clamp: Multi performance clamp, Rotation clamp 

 

Depth nose lock 

Nose height adjustment screw 
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It might be difficult to adjust the tool length if the nose height adjustment screw set to the top, so separate 

it about 1~2mm from the head.  

 

 

 

 

 

 

 

 

 

3. Assemble the nose height adjustment screw with the nose and turn the assembly to the right to make the nose’s 

tool hole locate before the tool tighten bolt. 

   

 

4. Put a flat plate (Ex: ruler) under the nose as shown in the picture below and release the tool fixing screw with 

2mm wrench. Lower the tool until it touches the plate, and tightens the tool in place. 

 

 

5. If the nose height adjustment bolt is rotated to the right, the nose will face to the top and the tool will be able  

to be seen. At this time, the engraving depth is same as the height of the exposed tool. Adjust the length of  

the tool to desired depth. (One revolution of the screw moves the tool 1mm up or down) 

* If the engraving depth is 1mm on the tool path, and the tool length is by 0.3mm, then the actual engraving 

depth will be 0.3mm. 

 

1~2mm 

Nose height adjustment 

Head 
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6. Rotate and tighten the depth nose lock to the right not to make the nose height adjustment screw loosened. 

If the depth nose lock is not fixed, the nose height adjustment screw might be loosened to change the 

engraving depth or cause damage to the material, tool or nose. 

 

 

 

 

 

 

7. Measure the length of tool at 7) Changing Tools (p.22 Spindle). 
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Drilling 
What is Drilling?  

It drills a hole with certain depth and diameter on materials by using endmill or V-cut tool. Depending on the tool 

thickness, the whole size becomes different sizes. 

 

Be sure to fix the engraver pressure lock. If the head is not fixed, the drilling may not be the 

designated depth. 

             

 

 

 

 

 

 

◈ Add drilling object  

If a drilling object is added and the screen is clicked with the mouse, a drilling object will be created. Drilling options 

of the created object such as drilling depth and speed can be changed on the object registration information 

window on the left of the screen.  
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The drilling tool path object can be copied and used in several constant gaps by using Edit menu → Copy → 

Multiple-copy. 

                    

 

 

 

 

Drag and move a drilling object with the mouse to drill it into various shapes.  
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◈ Fill Inside Object with Drilling Position 

 

 

 

 

Select a shape to be filled with the drilled object. Click “Insert → Drill →  Fill Inside Object with Drilling Position 

…”.  

 

 

Select a tool to be used on the Auto create drilled object window and adjust options such as depth, speed, gap  

etc. 

 

The drilled object is automatically created inside of the selected object in a designated gap.
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◈ Layout Drilling Position along Line 

The drilled object along can be allocated along the outline of the selected the object. 

 

 

 

Select a line on which the drilled object is automatically allocated. Click Insert → Drilling (beta) → Layout Drilling 

Position along with Line...  

 

 

Select a tool to be used on the Auto create drilled object window and adjust options such as depth, speed, gap 

and etc. 

 

 

The drilled object is automatically created along the outline of the selected object in a designated gap. 
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Image Engraving 
What is image engraving? 

This is an engraving method to express the shade of image with dots. 

 

 

 

1. Attach a material to be engraved to the clamp. 

2. If  [Image] button is clicked, open window will appear. Import the image to be engraved. 

  

 

3. Adjust the size and location of the image. 

 

  

Tool: Tip 

Clamp: Multi performance clamp 
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4. Click [Text Impact Engraving Tool path] button. 

 

5. Adjust image engraving option in punching option window. 

  

When engraving an image, bright part (white area) of image can be expressed by punching. Since 

darker image shows higher quality, adjust the brightness to dark. Normally, dot ratio 10-20% shows the   

best engraving quality for a portrait. According to the brightness and background of the image, the  

optimal image conditions are different. Properly adjust it while checking the image preview for  

engraving. 

 

If you are not familiar with the image adjustment, click “Recommend the best” button to automatically adjust the 

image. 
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6. Click “OK” button to create tool path for image engraving. After checking the tool path, click “Engraving” button. 

   

 

When engraving an image, white area of image is punched. So the result of the tool path is shown as 

negative image. 

7. Click “Start engraving” button and designate the engraving location. And then, press and hold  button 

until it beeps (more than 3 seconds) to start the engraving. 
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Pen Engraving Process 
 

 

 

1. Measure the width and diameter of the pen to be engraved. 

 

 

 

 

 

 

2. Set the pen in the engraver by using a pen clamp.  

 

 

3. Select pen template in the object registration information, and enter the width and diameter of the pen, and 

click “OK” button. 

 

 

  

Diameter 

Width 

Tool: Tip 

Clamp: Pen clamp, Rotation clamp 
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4. Once the template appears, press [Text Input] on the toolbar. Click the work area with the mouse and enter 

texts. 

  

 

5. After texts are entered, press [Selection] on the toolbar to enter object selection mode. After selecting 

entered character string, adjust the size and font of the object. If you want to place the object at the center of 

the work area, click  [Center in Page] button. 
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6. Once the design is completed, click [Hatching Tool path]. A tool path means a route along which a tool is 

moved for engraving. 

  

 

7. Select engraving option and tool from the “hatching tool path” window, and designate hatching gap and depth 

when necessary and click “Create tool path” button. 
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8. “Tool path” object is created. 

   

9. Click button.  

- 

10. Once “Output” window appears, specify how to measure engraving material. And then, click “Start engraving” 

button.  

 

11. Designate the location for engraving then press and hold  button until it beeps (more than 3 seconds) 

to start the engraving.   
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Curved Materials Engraving 
In case of bent materials, it may scratch the surface of materials after engraving lower part.  

 

1. Enter the thickness of curved surface to be engraved to automatically set up the Z moving height. Create a 

tool path and  Click [Engraving] button. 

 

2. Once “Output” window appears, click a bent part of the material flatness to show various kinds of the bent 

material. Select a shape the most similar to that of the material to be used and enter the thickness (thickness 

of the area to which the engraving is applied) of the material’s round part before clicking “Start engraving” 

button. 

 

 

 

 

 

 

Enter the thickness of the part 

to be engraved. 
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Entering Characters placed in a Circle  
You can engrave by placing characters in a circle on round shape materials. There are two types – circler placed 

characters and roundly placed characters in double layer. You can choose either one. 

 

[Circular Text]  

Click  button to display the characters to be placed in a circle window. Use “Direction and angle” button to 

select placement angle, and enter size, height and texts, and click “OK” button. 
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[Circular Text(Top/Bottom)] 

Click  button, then characters placed in a circle window appears. Enter the size of outer line and inner 

line, and texts, and click “OK” button. 

 

 

 

 

 

 

 

 

 

 

       

Adjust character angle 

Drag the first character [R] or last character [y] in the character string to adjust the angle of character string. 

 

            

                                  

Drag other characters with mouse to adjust the distance to the center of character string. 

            

 

 

Drag with mouse 

 

Drag with mouse 
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Entering Characters in a Curve  

1. Click the  [Line/Curve] button. 

2. Click on a certain point with the mouse and designate a distance. Drag while clicking and holding the mouse to 

make a curve appear. Press the right button on the mouse to create the curve. 

        

 

3. In the line shape box place the selected object in “NO line”. 

 

       

 

4. Click a  [Text Input] button, and move the mouse cursor to the curve line. The cursor shape will change like 

below. 

                 

 

5. In state of the changed cursor shape, click the left button of the mouse to the character input mode. 

 

  

[Mouse drag] 
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Preview Font 
Apply the fonts installed on the computer to the character string and preview the shape to select the font you will 

use. 

 

After entering characters, click “Preview” button in the object registration information window or click mouse  

right button, and click “Font preview.” Then, “Font preview” window will appear. 

 

If you drag the font list in the font preview window, or click a font while pressing “Ctrl” or “Shift” key, then the preview 

of the selected font appears automatically. Double click the preview image of font to select it. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 Preview image size will be larger. 

 Preview image size will be smaller. 

 

Show the list of Installed fonts. 



 

 104  

Change Texts 
You can change the contents of design sample you frequently use. 

Import a saved design sample or file, or select an object designed on the screen. Click [Text change] button  

or click mouse right button to click “Text change”.   

 

 

 Change contents in the “Text change” window, and click “OK” button. The changed texts will be shown on the 

screen. 
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Create Template  
Template is an image corresponding to the materials to be engraved by 1:1 ratio. Load a template most 

similar to the materials to be engraved, and enter the texts to be engraved. This way allows you to create 

the location of engraving and the size of texts to be engraved more easily and conveniently.  

Circle, heart, square and diamond templates are initially provided by the program and users can freely 

add more templates. The shape of a template can be designed by graphic program (Illustrator, Photoshop, 

CorelDraw, etc.) or a scan file of materials can be saved as jepg, bmp, png, srg file types to use. 

 

[Add template1] 

1. Click [Template] button, then “Template Library” window appears as below. Click the template list window 

with mouse right button and click Import button, then “Open” window will appear. 

    

2. Select picture files (jepg, bmp, png, etc.) from the “Open” window, and click “Open” button, then a window for 

naming appears. Enter a name for new template, and click “OK” button to add the template to the library. 

 

 

 

 

Click mouse right button in the template category window to add or delete a folder. Click the mouse right button in 

a template list window to delete template list. 
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[Add template2] 

1. Press [Image] button to import a picture file and save the size of image. 

 

2. Click [Template] button to show “Template Library” window.  

Click the template list window with mouse right button, and click “Save Selected” button. Enter new template name, 

and click “OK” button to add the template to the library.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The template saved in the “Save Selected” menu is saved as designated size to the screen. When 

designating template size, check “Maintain Original Size” and click OK button, then the template will be 

loaded with the size designated when saving the template. 

 

` 
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Saving as Design Sample 
Save the edited contents in Magic Art as design sample. You can use this whenever necessary. 

 

[Save 1] 

1. Enter the contents, and adjust the font and size as desired. Select the object and click “save” from “file → Save 

As Design Sample”. 

 

 

2. Designate a folder or create new folder. Enter the name and click “OK” button to add it to the design sample.  
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[Save 2] 

1. Select a designed object, and click [Design Sample] button. 

 

 

2. Select the folder where the object is saved from the design sample library window. Click the mouse right button, 

and click “Save selected” button. Enter the name to be saved, and click “OK” button to save it in the design 

sample library. 
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Auto Change of Serial Number 
Use this function when you change numbers by certain unit. 

Edit the font and size of character, and press “Alt+N” key on a keyboard, or click “Text → serial number → Advance 

Serial Number” to change the number automatically. 

 

               

Click “Text → serial number → Serial Number option” and designate a unit from the “Serial Number Auto 

Advancing Option” to change the serial number by the designated unit automatically. 

 

               

If the serial number is not regular, then click “Text → Serial Number → Load Serial Number” in the menu. Enter 

serial number in the “Load File…” field or click import. Import the serial number and click “Export to object” 

button. The screen texts are automatically changed, and the serial number will be deleted from the list. The 

deleted numbers will be shown in the “Exported Lines”. 
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Import serial number function can only import file separated by comma (.csv) or text file (.txt). Each row 

of the file will be recognized as one serial number, and the contents of each row separated by comma 

will be shown with linebreaks. 
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Add and Edit Picture 
1) Add picture 
This program provides a function to edit various types of picture files. Supported picture file types are as follows. 

BMP Windows or OS/2’s bitmap graphic file 

GIF CompuServe graphic file 

JPG/JPEG JPEG bitmap graphic file 

PNG Portable Network Graphics bitmap graphic file 

PCX Z Soft PC paintbrush bitmap file 

TIF/TIFF Tag Image File Format bitmap file 

WMF Windows meta file 

 

Picture file can be added by following methods. 

1. Select [Image] from the toolbar or “Insert → Image…” from the menu. 

       

2. If “Open” window shows up as the picture below, select the picture to be added, and click “Open” button. 
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3. Drag the work area by the mouse and decide picture size to load the picture. 
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2) Convert and edit picture file 

 

Only single color image can be engraved. Since color image cannot be engraved by this engraver, it should be 

converted to single color (1 bit) image. 

 

[Convert single color image] 

1. Select the image object you want to convert using mouse, and click “Transform” → “Bitmap” → “Mode” → 

“Monochrome (1bit)…” or “Convert” button in the image object registration information window to select 

“Monochrome (1bit).” 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2. The window to convert it to single color image appears as below. Adjust the slider to change it to the single color 

you want, and click “OK” button. 
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[Edit image] 

Loaded image can be edited by third party program (picture edition). Select the image to be edited, and click 

mouse right button. Click “Edit” button or select “Bitmap” → “Edit...” from “Transform." Then, third party program 

(Paint) shows the image. After editing it, press “Save” from the file menu, and close the third party program (Paint) 

to apply the edition. 
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Import a File in SVG Type 
Magic Art supports vector graphic (SVG) files. So files saved as SVG type can be imported. If you save a design 

as SVG type from design program Illustrator or CorelDraw, you can import the file to the Magic Art. 

 

1. Click “File” → “Save As” button from Illustrator program menu to save a file in SVG type. 

 

 

 

 

2. SVG option window appears; uncheck the checkbox next to “Preserve Illustrator Editing Capabilities”. Then 

press the “OK” button to complete the save. 
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3. Click “File” → “Import” button from the Magic Art menu to import a file. 
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Origin Point Calibration 

※ The machine is initially set up at factory. Please contact reseller before changing the machine 

settings. 

※ Calibrate the machine by using tip(Carbide, Diamond). The machine cannot be calibrated by using 

endmill, cutter, etc. 

※ Calibrate the machine while Engraver pressure lock is not fixed. The nose, tool, and material can 

be damaged if you calibrate the machine while the head is fixed. 

 

1) Tool Calibration (touch) 
1. Fix a material of flat surface on the clamp. 

2. Fix the tool short enough. 

3. Press  button to move the tool to the clamp. 

4. Press  button and go to the menu mode. 

5. Press  button, and when  menu appears on the LCD window, then press 

and hold  button until it beeps (more than 3 seconds) to run the menu. 

6. Select the “1.Touch Sensor” then press and hold  button until it beeps (more than 3 seconds) to run 

the menu. 

 

7. The tool will be lowered down to the material hold in the center of the clamp. 

 

8. Lower the tool manually by loosening the fixing bolt of the tool with a wrench, or raise the materials you're your 

hands to make the tool and materials touch as shown in the picture below. 

 

 

 

 

 

 

9. Press and hold  button until it beeps (more than 3 seconds) to confirm that the setting is saved, then the 

tool will measure the material’s height. 

The tool touches on the material 
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2) Probe Calibration 
1. Fix a material of flat surface on the clamp. 

2. Press the  button and go to the expert menu mode. 

3. Press  button, and when  menu appears on the LCD window, then press 

and hold  button for more than 3 second until it beeps (more than 3 seconds) to run the menu. 

4. Select the “2.Probe” then press and hold  button until it beeps (more than 3 seconds) to run the menu. 

5. When  appears on the LCD window, press button to appear  

on the LCD window, then press Z axis button to lower the tool to make it 

close to the materials, and release the tool by using a wrench until the tool touches the materials. Then tighten the 

tool. 

6. Press and hold  button until it beeps (more than 3 seconds), then the probe measures the height of the 

materials and the length of the tool before the settings is saved. 

                             

7. Press and hold  button until it beeps (more than 3 seconds) to begin a test run.  

At this time, the tool draws four lines on the materials. If two lines out of four lines are seen one the materials, 

then it is appropriate. If three lines are seen on the materials, then press  button to raise it by 0.05mm, 

and one line is seen, then press Z axis  button to lower it down by 0.05mm  

                      

※0.05mm per line . 
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3) Laser Pointer Calibration 

◈ Spindle 

1. Fix a material of flat surface on the clamp. 

2. Press  button to move the tool to the clamp. 

3. Press  button and go to the expert menu mode. 

4. Press  button, and when  menu appears on the LCD window, then press 

and hold  button until it beeps (more than 3 seconds) to run the menu. 

5. Select the “3. Pointer/Flat” then press and hold  button until it beeps (more than 3 seconds) to run the 

menu. 

 

6. The tool draws cross (＋) lines on the materials and the laser pointer is turned on. 

7. Move the laser pointer to the center of the cross by using the direction key. Then 

press and hold button. 

 

 

 

 

 

8. Laser pointer moves closer to the material to accurately calibrate the laser pointer’s origin. 

Move the laser pointer to the center of the cross by using the  direction key on engraver, 

and press and hold the  button until it beeps (more than 3 seconds) to confirm that the setting is saved. 

◈ Rotation clamp 
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1. Turn the clamp knob on the left side of the clamp and pull the clamp and spacer block to take it out.  

 

 

 

 

 

 

2. Fix a ring on flat surface of the rotation clamp. (Ring Outer Diameter Max.18mm) 

 

3. Press the  button and go to the expert menu mode. 

4. Press  button, and when  menu appears on the LCD window, then press 

and hold  button until it beeps (more than 3 seconds) to run the menu. 

5. Select the “4.Pointer/Rotary” then press and hold  button until it beeps (more than 3 seconds) to run 

the menu. 

6. The tool draws cross (+) on the materials, and the laser pointer is turned on. 

7. Use the  direction key to move the laser pointer to the center of the cross, and press 

and hold button for more than 2 seconds to save the settings. 

 

 

 

 

 

8. Laser pointer moves closer to the material to accurately calibrate the laser pointer’s origin. 

Move the laser pointer to the center of the cross by using the  direction key on engraver, 

and press and hold the  button until it beeps (more than 3 seconds) to confirm that the setting is saved. 
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123  

◈ L-Tool 

1. Turn the clamp knob on the left side of the clamp and pull the clamp and spacer block to take it out.  

 

 

 

 

 

 

2. Fix a ring on flat surface of the rotation clamp. (Ring Outer Diameter Max.18mm) 

 

3. Press the  button and go to the expert menu mode. 

4. Press  button, and when  menu appears on the LCD window, then press 

and hold  button until it beeps (more than 3 seconds) to run the menu. 

5. Select the “5.Pointer/L-Tool” then press and hold  button until it beeps (more than 3 seconds) to run 

the menu. 

6. When message appears on the LCD window like below, pull the L-Tool down by L-Tool line 1. Then press 

button.  

 

 

 

 

 

7. The tool draws cross (＋) lines on the materials. 

8. When message appears  on the LCD window, pull up the L-Tool. And the laser pointer is 

turned on 
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9. Move the laser pointer to the center of the cross by using the direction key, and press 

and hold the  button until it beeps (more than 3 seconds) to confirm that the setting is saved. 

 

 

 

 

 

10. Laser pointer moves closer to the material to accurately calibrate the laser pointer’s origin. 

Move the laser pointer to the center of the cross by using the  direction key on engraver, 

and press and hold the  button until it beeps (more than 3 seconds) to confirm that the setting is saved. 

 

4) Saving Multi-performance Clamp Origin Position 
1. Put a dot on the center of the material with the marker, and fix it at the center of the clamp. 

 

2. Press  button to move to flat mode. 

※Menu will be changed if you enter ring inner/outer diameter mode menu. 

3. Press  button and go to the menu mode. 

4. Press  button, and when  menu appears on the LCD window, then press 

and hold  button until it beeps (more than 3 seconds) to run the menu. 

5.  Select an “Origin No” and press and hold  button to enter the

 . And select the “CENTER” by using the direction key, then 

press and hold  button until it beeps (more than 3 seconds) to move to the origin.  
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6. Press  button to turn on the laser pointer on the clamp. 

7. Move the laser pointer to the center of the dot by using the direction key. 

 

 

 

 

 

8. Press and hold the  button until it beeps (more than 3 seconds) to confirm that the setting is saved. 

9. When menu appears on the LCD window like below, select the “CENTER” by using the  buttons. 

                        

10. Press and hold the  button until it beeps (more than 3 seconds) to confirm that the setting is saved. 

11. Tool will be moved to the position stored in the button. 

 

5) Saving New Clamp Origin Position 

1. Press  button to move to flat mode. 

※Menu will be changed if you enter ring inner/outer diameter mode menu. 

2. Press  button and go to the expert menu mode. 

3. Press  button, and when  menu appears on the LCD window, then press 

and hold  button until it beeps (more than 3 seconds) to run the menu. 

4.  Select a “Clamp” and “Origin” what you want by using the 

direction key, then press and hold  button until it beeps (more than 3 seconds) to move to the origin. 

5. Press  button to turn on the laser pointer on the clamp. 

6. Move the laser pointer to the point what you want by using the direction key, and 
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press and hold the  button until it beeps (more than 3 seconds) to confirm that the setting is saved. 

7. When menu appears on the LCD window like below, select the “Origin” what you want by using the 

 buttons. 

                        

8. Press and hold the  button until it beeps (more than 3 seconds) to confirm that the setting is saved. 

9. Tool will be moved to the position stored in the button. 

 

6) Chuck Finger Origin point 
1. Set the chuck finger to the rotation clamp of the engraver. 

        

     Flat chuck finger              Round chuck finger 

2. Press  or  button to turn on the laser pointer at the Origin of the chuck finger. 

3. Use the direction key of the engraver to match the laser pointer to the base point of each chuck finger as below. 

        

4. Press and hold  or  button until it beeps (more than 3 seconds) to confirm that the setting is saved. 

 

7) Rotation Clamp Origin point (Z axis) 
1. Set the sharp tool into the rotation chuck of the engraver as shown in the picture below. 
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2. Press  button on the engraver to move the tool to the center of rotation clamp. 

3. Pull the L-Tool down by L-Tool line 1. 

 

 

 

 

 

 

 

 

 

4. Use  buttons to align the end ㅋㅋof the ring inner diameter engraving tool and tip of the sharp 

tool on the same horizontal line. If the distance between the tool and the sharp tool is too far, then bring them 

closer by using  button. 

 

5. Press  button for more than 2 seconds, then the message below will appear. Press  button for 

more than 2 seconds to save the setting. 

           

 

6. Pull up the L-Tool. 

 


